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Editor for ASP.NET AJAX Overview
The powerful editing control, ComponentOne Editor for ASP.NET AJAX, 
enables even non-technical users to author and manage HTML content on any 
Web page. The What-You-See-is-What-You Get (WYSIWYG) editor replaces 
generic text boxes with an intuitive Microsoft Word-like editor.

Offering various modes of editing (design, source code, and split), this versatile 
tool gives end users the option to edit HTML content in their preferred style. 
The familiar user interface includes a top toolbar panel region, middle text 
window, and bottom toolbar panel region. The customizable ribbon panels, 
built-in spell checker, and complete JavaScript client-side object model allow 
you to easily manipulate your text – with or without code.

Getting Started

- Quick Start (page 18)

- Design-Time 
Support (page 28)

- Run-Time Elements
(page 52)

What's New in Editor for ASP.NET AJAX
No new features have been added the C1Editor control in the 2010 v2 release of Editor for ASP.NET AJAX.

Tip: A version history containing a list of new features, improvements, fixes, and changes for each product 
is available at HelpCentral at http://helpcentral.componentone.com/

Revision History
This section provides revision histories for up to the last three releases of Editor for ASP.NET AJAX.

What’s New in 2010 v1

No new features were added the C1Editor control in the 2010 v1 release of Editor for ASP.NET AJAX.

What's New in 2009 v3

You can now add words to the dictionary during spell checking.

What's New in 2009 v2

The following features were added for the v209 release of Editor for ASP.NET AJAX.

New Features

 Remove Hyperlink and Edit Hyperlink options have been added to the C1Editor context menu.

http://helpcentral.componentone.com/
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For more information on the context menu, see C1Editor Run-Time Context Menu (page 52).

 A new context menu was added to show spelling suggestions. This context menu will only appear if the 
ShowSpellCheckerDialog property is set to False.

For more information on the new context menu, see C1Editor Spell Checker Context Menu (page 52) and 
Replacing the Spell Checker Dialog Box with a Context Menu (page 64).

New Members

The following members have been added to Editor for ASP.NET AJAX:

Member Description

ShowSpellCheckerDialog Indicates whether to show SpellChecker dialog box or to allow a user to 
select suggestions from context menu instead.

TextChanged event This event is fired when the text in the text editor has changed.

TextSaved event This event is fired when the text in the text editor is saved.

New Topics

The following topics have been added to Editor for ASP.NET AJAX:

Topic Description

C1Editor Spell Checker
Context Menu (page 52)

Describes the context menu that is used to show the user suggested 
spellings for a misspelled word.

Replacing the Spell Checker 
Dialog Box with a Context 
Menu (page 64)

Explains how to set the ShowSpellCheckerDialog property to False so 
that the users can use a context menu instead of a dialog box to select 
from a list of spellling suggestions.
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Installing Editor for ASP.NET AJAX
The following sections provide helpful information on installing Editor for ASP.NET AJAX:

Editor for ASP.NET AJAX Setup Files

The ComponentOne Studio for ASP.NET installation program will create the following directory: C:\Program 
Files\ComponentOne\Studio for ASP.NET. This directory contains the following subdirectories:

bin Contains copies of all binaries (DLLs, EXEs) in the 
ComponentOne Visual Studio ASP.NET package.

H2Help Contains documentation for Studio for ASP.NET components.

C1WebUi Contains files (at least a readme.txt) related to the product. 

C1WebUi\VisualStyles Contains all external file themes.

Samples

Samples for the product are installed in the ComponentOne Samples folder by default. The path of the 
ComponentOne Samples directory is slightly different on Windows XP and Windows 7/Vista machines:

Windows XP path: C:\Documents and Settings\<username>\My Documents\ComponentOne Samples

Windows 7/Vista path: C:\Users\<username>\Documents\ComponentOne Samples

The ComponentOne Samples folder contains the following subdirectories:

Common Contains support and data files that are used by many of the 
demo programs.

Studio for 
ASP.NET\C1WebUi

Contains a readme.txt file and the folders that make up the 
Control Explorer and other samples.

You can access samples from the ComponentOne Control Explorer. To view samples, click the Start button and 
then click ComponentOne | Studio for ASP.NET | Control Explorer.

System Requirements

System requirements for ComponentOne Studio for ASP.NET components include the following:

Operating Systems: Windows® 2000

Windows Server® 2003

Windows Server 2008

Windows XP SP2

Windows Vista™

Windows 7

Web Server: Microsoft Internet Information Services (IIS) 5.0 or later

Environments: .NET Framework 2.0 or later

Visual Studio 2005 or Visual Studio 2008

Internet Explorer 6.0 or later

Firefox® 2.0 or later

Safari® 2.0 or later
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Disc Drive: CD or DVD-ROM drive if installing from CD

Uninstalling Editor for ASP.NET AJAX

To uninstall Studio for ASP.NET:

1. Open the Control Panel application and select Add or Remove Programs (Programs and Features in 
Vista/7). 

2. Select ComponentOne Studio for ASP.NET and click the Remove button.

3. Click Yes to remove the program.

Deploying your Application in a Medium Trust Environment

Depending on your hosting choice, you may need to deploy your Web site or application in a medium trust 
environment. Often in a shared hosting environment, medium trust is required. In a medium trust environment 
several permissions are unavailable or limited, including OleDbPermission, ReflectionPermission, and 
FileIOPermission. You can configure your Web.config file to enable these permissions.

Note: ComponentOne controls will not work in an environment where reflection is not allowed.

ComponentOne ASP.NET controls include the AllowPartiallyTrustedCallers() assembly attribute and will work 
under the medium trust level with some changes to the Web.config file.  Since this requires some control over the 
Web.config file, please check with your particular host to determine if they can provide the rights to override these 
security settings.

Modifying or Editing the Config File

In order to add permissions, you can edit the exiting web_mediumtrust.config file or create a custom policy file 
based on the medium trust policy. If you modify the existing web_mediumtrust.config file, all Web applications 
will have the same permissions with the permissions you have added. If you want applications to have different 
permissions, you can instead create a custom policy based on medium trust.

Edit the Config File

In order to add permissions, you can edit the exiting web_mediumtrust.config file. To edit the exiting 
web_mediumtrust.config file, complete the following steps:

1. Locate the medium trust policy file web_mediumtrust.config located by default in the 
%windir%\Microsoft.NET\Framework\{Version}\CONFIG directory.

2. Open the web_mediumtrust.config file.

3. Add the permissions that you want to grant. For examples, see Adding Permissions (page 5).

Create a Custom Policy Based on Medium Trust

In order to add permissions, you can create a custom policy file based on the medium trust policy. To create a 
custom policy file, complete the following steps:

1. Locate the medium trust policy file web_mediumtrust.config located by default in the 
%windir%\Microsoft.NET\Framework\{Version}\CONFIG directory.

2. Copy the web_mediumtrust.config file and create a new policy file in the same directory.

Give the new a name that indicates that it is your variation of medium trust; for example, 
AllowReflection_Web_MediumTrust.config. 

3. Add the permissions that you want to grant. For examples, see Adding Permissions (page 5).

4. Enable the custom policy file on your application by modifying the following lines in your web.config file 
under the <system.web> node:
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<system.web>
<trust level="CustomMedium" originUrl=""/>
<securityPolicy>
<trustLevel name="CustomMedium"
policyFile="AllowReflection_Web_MediumTrust.config"/>
</securityPolicy>

...
</system.web>

Note: Your host may not allow trust level overrides. Please check with your host to see if you have these rights.

Allowing Deserialization

To allow the deserialization of the license added to App_Licenses.dll by the Microsoft IDE, you should add the 
SerializationFormatter flag to security permission to the Web.config file. Complete the steps in the Modifying or 
Editing the Config File (page 4) topic to create or modify a policy file before completing the following.

Add the SerializationFormatter flag to the <IPermission class="SecurityPermission"> tag so 
that it appears similar to the following:

<NamedPermissionSets>
<PermissionSet
class="NamedPermissionSet"
version="1"
Name="ASP.Net">
<IPermission
class="SecurityPermission"
version="1"
Flags="Assertion, Execution, ControlThread, ControlPrincipal, 

RemotingConfiguration, SerializationFormatter"/>
      ...

</PermissionSet>
</NamedPermissionSets>

Adding Permissions

You can add permission, including ReflectionPermission, OleDbPermission, and FileIOPermission, to the 
web.config file. Note that ComponentOne controls will not work in an environment where reflection is not 
allowed. Complete the steps in the Modifying or Editing the Config File (page 4) topic to create or modify a policy 
file before completing the following.

ReflectionPermission

By default ReflectionPermission is not available in a medium trust environment. ComponentOne ASP.NET 
controls require reflection permission because LicenseManager.Validate() causes a link demand for full trust. 

To add reflection permission, complete the following:

1. Open the web_mediumtrust.config file or a file created based on the web_mediumtrust.config file.

2. Add the following <SecurityClass> tag after the <SecurityClasses> tag so that it appears similar 
to the following:

<SecurityClasses>
<SecurityClass Name="ReflectionPermission"
Description="System.Security.Permissions.ReflectionPermission, mscorlib, 
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089"/>
...
</SecurityClasses>
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3. Add the following <IPermission> tag after the <NamedPermissionSets> tag so it appears similar 
to the following:

<NamedPermissionSets>
<PermissionSet class="NamedPermissionSet" version="1" Name="ASP.Net">
<IPermission
class="ReflectionPermission"
version="1"
Flags="ReflectionEmit,MemberAccess" />
        ...
</PermissionSet>
</NamedPermissionSets>

4. Save and close the web_mediumtrust.config file.

OleDbPermission

By default OleDbPermission is not available in a medium trust environment. This means you cannot use the 
ADO.NET managed OLE DB data provider to access databases. If you wish to use the ADO.NET managed OLE 
DB data provider to access databases, you must modify the web_mediumtrust.config file.

To add OleDbPermission, complete the following steps:

1. Open the web_mediumtrust.config file or a file created based on the web_mediumtrust.config file.

2. Add the following <SecurityClass> tag after the <SecurityClasses> tag so that it appears similar 
to the following:

<SecurityClasses>
<SecurityClass Name="OleDbPermission"
Description="System.Data.OleDb.OleDbPermission, System.Data, 
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089"/>
...
</SecurityClasses>

3. Add the following <IPermission> tag after the <NamedPermissionSets> tag so it appears similar
to the following:

<NamedPermissionSets>
<PermissionSet class="NamedPermissionSet" version="1" Name="ASP.Net">
<IPermission class="OleDbPermission" version="1" Unrestricted="true"/>
        ...
</PermissionSet>
</NamedPermissionSets>

4. Save and close the web_mediumtrust.config file.

FileIOPermission

By default, FileIOPermission is not available in a medium trust environment.  This means no file access is 
permitted outside of the application's virtual directory hierarchy.  If you wish to allow additional file permissions, 
you must modify the  web_mediumtrust.config file.  

To modify FileIOPermission to allow read access to a specific directory outside of the application's virtual 
directory hierarchy, complete the following steps:

1. Open the web_mediumtrust.config file or a file created based on the web_mediumtrust.config file.

2. Add the following <SecurityClass> tag after the <SecurityClasses> tag so that it appears 
similar to the following:

<SecurityClasses>
<SecurityClass Name="FileIOPermission"
Description="System.Security.Permissions.FileIOPermission, mscorlib, 
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089"/>
...
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</SecurityClasses>

3. Add the following <IPermission> tag after the <NamedPermissionSets> tag so it appears similar 
to the following:

<NamedPermissionSets>
<PermissionSet class="NamedPermissionSet" version="1" Name="ASP.Net">
    ...
<IPermission class="FileIOPermission" version="1"
Read="C:\SomeDir;$AppDir$" Write="$AppDir$" Append="$AppDir$"
PathDiscovery="$AppDir$" />
  ...
</PermissionSet>
</NamedPermissionSets>

4. Save and close the web_mediumtrust.config file.

End-User License Agreement
All of the ComponentOne licensing information, including the ComponentOne end-user license agreements, 
frequently asked licensing questions, and the ComponentOne licensing model, is available online at 
http://www.componentone.com/SuperPages/Licensing/.

Licensing FAQs
This section describes the main technical aspects of licensing. It may help the user to understand and resolve 
licensing problems he may experience when using ComponentOne .NET and ASP.NET products.

What is Licensing?

Licensing is a mechanism used to protect intellectual property by ensuring that users are authorized to use software 
products.

Licensing is not only used to prevent illegal distribution of software products. Many software vendors, including 
ComponentOne, use licensing to allow potential users to test products before they decide to purchase them.

Without licensing, this type of distribution would not be practical for the vendor or convenient for the user. 
Vendors would either have to distribute evaluation software with limited functionality, or shift the burden of 
managing software licenses to customers, who could easily forget that the software being used is an evaluation 
version and has not been purchased.

How does Licensing Work?

ComponentOne uses a licensing model based on the standard set by Microsoft, which works with all types of 
components.

Note: The Compact Framework components use a slightly different mechanism for run-time licensing than the 
other ComponentOne components due to platform differences.

When a user decides to purchase a product, he receives an installation program and a Serial Number. During the 
installation process, the user is prompted for the serial number that is saved on the system. (Users can also enter 
the serial number by clicking the License button on the About Box of any ComponentOne product, if available, or 
by rerunning the installation and entering the serial number in the licensing dialog.)

When a licensed component is added to a form or Web page, Visual Studio obtains version and licensing 
information from the newly created component. When queried by Visual Studio, the component looks for 
licensing information stored in the system and generates a run-time license and version information, which Visual 
Studio saves in the following two files: 

http://www.componentone.com/SuperPages/Licensing/
http://www.componentone.com/SuperPages/Licensing/
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 An assembly resource file which contains the actual run-time license

 A "licenses.licx" file that contains the licensed component strong name and version information

These files are automatically added to the project.

In WinForms and ASP.NET 1.x applications, the run-time license is stored as an embedded resource in the 
assembly hosting the component or control by Visual Studio. In ASP.NET 2.x applications, the run-time license 
may also be stored as an embedded resource in the App_Licenses.dll assembly, which is used to store all run-time 
licenses for all components directly hosted by WebForms in the application. Thus, the App_licenses.dll must 
always be deployed with the application.

The licenses.licx file is a simple text file that contains strong names and version information for each of the 
licensed components used in the application. Whenever Visual Studio is called upon to rebuild the application 
resources, this file is read and used as a list of components to query for run-time licenses to be embedded in the 
appropriate assembly resource. Note that editing or adding an appropriate line to this file can force Visual Studio 
to add run-time licenses of other controls as well.

Note that the licenses.licx file is usually not shown in the Solution Explorer; it appears if you press the Show All 
Files button in the Solution Explorer's Toolbox, or from Visual Studio's main menu, select Show All Files on the 
Project menu.

Later, when the component is created at run time, it obtains the run-time license from the appropriate assembly 
resource that was created at design time and can decide whether to simply accept the run-time license, to throw an 
exception and fail altogether, or to display some information reminding the user that the software has not been 
licensed. 

All ComponentOne products are designed to display licensing information if the product is not licensed. None will 
throw licensing exceptions and prevent applications from running.

Common Scenarios

The following topics describe some of the licensing scenarios you may encounter.

Creating components at design time

This is the most common scenario and also the simplest: the user adds one or more controls to the form, the 
licensing information is stored in the licenses.licx file, and the component works.

Note that the mechanism is exactly the same for Windows Forms and Web Forms (ASP.NET) projects.

Creating components at run time 

This is also a fairly common scenario. You do not need an instance of the component on the form, but would like 
to create one or more instances at run time.

In this case, the project will not contain a licenses.licx file (or the file will not contain an appropriate run-time 
license for the component) and therefore licensing will fail.

To fix this problem, add an instance of the component to a form in the project. This will create the licenses.licx file 
and things will then work as expected. (The component can be removed from the form after the licenses.licx file 
has been created).

Adding an instance of the component to a form, then removing that component, is just a simple way of adding a 
line with the component strong name to the licenses.licx file. If desired, you can do this manually using notepad or 
Visual Studio itself by opening the file and adding the text. When Visual Studio recreates the application resources, 
the component will be queried and its run-time license added to the appropriate assembly resource.

Inheriting from licensed components

If a component that inherits from a licensed component is created, the licensing information to be stored in the 
form is still needed. This can be done in two ways:
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 Add a LicenseProvider attribute to the component.

This will mark the derive component class as licensed. When the component is added to a form, Visual 
Studio will create and manage the licenses.licx file, and the base class will handle the licensing process as 
usual. No additional work is needed. For example:
    [LicenseProvider(typeof(LicenseProvider))]
    class MyGrid: C1.Win.C1FlexGrid.C1FlexGrid
    {
// ...
    }

 Add an instance of the base component to the form.

This will embed the licensing information into the licenses.licx file as in the previous scenario, and the 
base component will find it and use it. As before, the extra instance can be deleted after the licenses.licx 
file has been created.

Using licensed components in console applications

When building console applications, there are no forms to add components to, and therefore Visual Studio won't 
create a licenses.licx file.

In these cases, create a temporary Windows Forms application and add all the desired licensed components to a 
form. Then close the Windows Forms application and copy the licenses.licx file into the console application 
project.

Make sure the licenses.licx file is configured as an embedded resource. To do this, right-click the licenses.licx file in 
the Solution Explorer window and select Properties. In the Properties window, set the Build Action property to 
Embedded Resource.

Using licensed components in Visual C++ applications

There is an issue in VC++ 2003 where the licenses.licx is ignored during the build process; therefore, the licensing 
information is not included in VC++ applications.

To fix this problem, extra steps must be taken to compile the licensing resources and link them to the project. Note 
the following:

1. Build the C++ project as usual. This should create an exe file and also a licenses.licx file with licensing 
information in it.

2. Copy the licenses.licx file from the app directory to the target folder (Debug or Release). 

3. Copy the C1Lc.exe utility and the licensed .dlls to the target folder. (Don't use the standard lc.exe, it has 
bugs.)

4. Use C1Lc.exe to compile the licenses.licx file. The command line should look like this:
c1lc /target:MyApp.exe /complist:licenses.licx /i:C1.Win.C1FlexGrid.dll 

5. Link the licenses into the project. To do this, go back to Visual Studio, right-click the project, select 
Properties, and go to the Linker/Command Line option. Enter the following:
/ASSEMBLYRESOURCE:Debug\MyApp.exe.licenses 

6. Rebuild the executable to include the licensing information in the application.

Troubleshooting

We try very hard to make the licensing mechanism as unobtrusive as possible, but problems may occur for a 
number of reasons.

Below is a description of the most common problems and their solutions.
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I have a licensed version of a ComponentOne product but I still get the splash screen when I run my 
project.

If this happens, there may be a problem with the licenses.licx file in the project. It either doesn't exist, contains 
wrong information, or is not configured correctly.

First, try a full rebuild (Rebuild All from the Visual Studio Build menu). This will usually rebuild the correct 
licensing resources.

If that fails follow these steps:

1. Open the project and go to the Solution Explorer window. 

2. Click the Show All Files button on the top of the window.

3. Find the licenses.licx file and open it. If prompted, continue to open the file.

4. Change the version number of each component to the appropriate value. If the component does not 
appear in the file, obtain the appropriate data from another licenses.licx file or follow the alternate 
procedure following.

5. Save the file, then close the licenses.licx tab.

6. Rebuild the project using the Rebuild All option (not just Rebuild).

Alternatively, follow these steps:

1. Open the project and go to the Solution Explorer window. 

2. Click the Show All Files button on the top of the window.

3. Find the licenses.licx file and delete it.

4. Close the project and reopen it.

5. Open the main form and add an instance of each licensed control.

6. Check the Solution Explorer window, there should be a licenses.licx file there.

7. Rebuild the project using the Rebuild All option (not just Rebuild).

For ASP.NET 2.x applications, follow these steps:

1. Open the project and go to the Solution Explorer window. 

2. Find the licenses.licx file and right-click it.

3. Select the Rebuild Licenses option (this will rebuild the App_Licenses.licx file).

4. Rebuild the project using the Rebuild All option (not just Rebuild).

I have a licensed version of a ComponentOne product on my Web server but the components still 
behave as unlicensed.

There is no need to install any licenses on machines used as servers and not used for development.

The components must be licensed on the development machine, therefore the licensing information will be saved 
into the executable (.exe or .dll) when the project is built. After that, the application can be deployed on any 
machine, including Web servers.

For ASP.NET 2.x applications, be sure that the App_Licenses.dll assembly created during development of the 
application is deployed to the bin application bin directory on the Web server.

If your ASP.NET application uses WinForms user controls with constituent licensed controls, the run-time license 
is embedded in the WinForms user control assembly. In this case, you must be sure to rebuild and update the user 
control whenever the licensed embedded controls are updated.
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I downloaded a new build of a component that I have purchased, and now I'm getting the splash screen 
when I build my projects.

Make sure that the serial number is still valid. If you licensed the component over a year ago, your subscription 
may have expired. In this case, you have two options:

Option 1 – Renew your subscription to get a new serial number. 

If you choose this option, you will receive a new serial number that you can use to license the new components
(from the installation utility or directly from the About Box).

The new subscription will entitle you to a full year of upgrades and to download the latest maintenance builds 
directly from http://prerelease.componentone.com/.

Option 2 – Continue to use the components you have.

Subscriptions expire, products do not. You can continue to use the components you received or downloaded while 
your subscription was valid.

Technical Support
ComponentOne offers various support options. For a complete list and a description of each, visit the 
ComponentOne Web site at http://www.componentone.com/Support.

Some methods for obtaining technical support include:

 Online Support via HelpCentral
ComponentOne HelpCentral provides customers with a comprehensive set of technical resources in the 
form of FAQs, samples, Version Release History, Articles, searchable Knowledge Base, searchable Online 
Help and more. We recommend this as the first place to look for answers to your technical questions.

 Online Support via our Incident Submission Form
This online support service provides you with direct access to our Technical Support staff via an online 
incident submission form. When you submit an incident, you will immediately receive a response via e-
mail confirming that you've successfully created an incident. This email will provide you with an Issue 
Reference ID and will provide you with a set of possible answers to your question from our 
Knowledgebase. You will receive a response from one of the ComponentOne staff members via e-mail in 
2 business days or less.

 Peer-to-Peer Product Forums and Newsgroups
ComponentOne peer-to-peer product forums and newsgroups are available to exchange information, tips, 
and techniques regarding ComponentOne products. ComponentOne sponsors these areas as a forum for 
users to share information. While ComponentOne does not provide direct support in the forums and 
newsgroups, we periodically monitor them to ensure accuracy of information and provide comments 
when appropriate. Please note that a ComponentOne User Account is required to participate in the 
ComponentOne Product Forums.

 Installation Issues
Registered users can obtain help with problems installing ComponentOne products. Contact technical 
support by using the online incident submission form or by phone (412.681.4738). Please note that this 
does not include issues related to distributing a product to end-users in an application.

 Documentation
ComponentOne documentation is installed with each of our products and is also available online at 
HelpCentral. If you have suggestions on how we can improve our documentation, please email the 
Documentation team. Please note that e-mail sent to the Documentation team is for documentation 
feedback only. Technical Support and Sales issues should be sent directly to their respective departments.

Note: You must create a ComponentOne Account and register your product with a valid serial number to obtain 
support using some of the above methods.

http://prerelease.componentone.com/
http://www.componentone.com/Support
http://helpcentral.componentone.com/
http://helpcentral.componentone.com/ProductResources.aspx?View=FAQs
http://helpcentral.componentone.com/ProductResources.aspx?View=SAMPLES
http://helpcentral.componentone.com/ProductResources.aspx?View=VersionHistory
http://helpcentral.componentone.com/Articles.aspx
http://helpcentral.componentone.com/Search.aspx
http://helpcentral.componentone.com/Search.aspx
http://helpcentral.componentone.com/Search.aspx
http://helpcentral.componentone.com/Forums.aspx
http://helpcentral.componentone.com/Documentation.aspx
http://helpcentral.componentone.com/Documentation.aspx
mailto:documentation@componentone.com
mailto:documentation@componentone.com
mailto:documentation@componentone.com
http://www.componentone.com/support
mailto:sales@componentone.com
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Redistributable Files
ComponentOne Studio for ASP.NET is developed and published by ComponentOne LLC. You may use it to 
develop applications in conjunction with Microsoft Visual Studio or any other programming environment that 
enables the user to use and integrate the control(s). You may also distribute, free of royalties, the following 
Redistributable Files with any such application you develop to the extent that they are used separately on a single 
CPU on the client/workstation side of the network:

 C1.Web.UI.2.dll

 C1.Web.UI.Controls.2.dll

 C1.Web.UI.3.dll

 C1.Web.UI.Controls.3.dll

 C1.Web.UI.4.dll

 C1.Web.UI.Design.4.dll

 C1.Web.UI.Controls.4.dll

Site licenses are available for groups of multiple developers. Please contact Sales@ComponentOne.com for details.

About This Documentation
Acknowledgements

Microsoft, Windows, Windows Vista, and Visual Studio are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries.

Firefox is a registered trademark of the Mozilla Foundation.

Safari is a trademark of Apple, Inc., registered in the United States and other countries.

ComponentOne

If you have any suggestions or ideas for new features or controls, please call us or write:

Corporate Headquarters

ComponentOne LLC
201 South Highland Avenue
3rd Floor
Pittsburgh, PA 15206 • USA
412.681.4343
412.681.4384 (Fax)

http://www.componentone.com

ComponentOne Doc-To-Help

This documentation was produced using ComponentOne Doc-To-Help® Enterprise.

Namespaces
Namespaces organize the objects defined in an assembly. Assemblies can contain multiple namespaces, which can 
in turn contain other namespaces. Namespaces prevent ambiguity and simplify references when using large groups 
of objects such as class libraries. 

The general namespace for ComponentOne Web products is C1.Web. The following code fragment shows how to 
declare a C1Editor (which is one of the core Studio for ASP.NET classes) using the fully qualified name for this 
class:

mailto:sales@componentone.com
http://www.componentone.com/
http://www.componentone.com/
http://www.componentone.com/
http://www.doctohelp.com/
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 Visual Basic
Dim Editor As C1.Web.UI.Controls.C1Editor

 C#
C1.Web.UI.Controls.C1Editor Editor;

Namespaces address a problem sometimes known as namespace pollution, in which the developer of a class library is 
hampered by the use of similar names in another library. These conflicts with existing components are sometimes 
called name collisions.

Fully qualified names are object references that are prefixed with the name of the namespace where the object is 
defined. You can use objects defined in other projects if you create a reference to the class (by choosing Add 
Reference from the Project menu) and then use the fully qualified name for the object in your code. 

Fully qualified names prevent naming conflicts because the compiler can always determine which object is being 
used. However, the names themselves can get long and cumbersome. To get around this, you can use the Imports 
statement (using in C#) to define an alias — an abbreviated name you can use in place of a fully qualified name. 
For example, the following code snippet creates aliases for two fully qualified names, and uses these aliases to 
define two objects:

 Visual Basic
Imports C1Editor = C1.Web.UI.Controls.C1Editor
Imports MyEditor = MyProject.Objects.C1Editor
Dim wm1 As C1Editor
Dim wm2 As MyEditor

 C#
using C1Editor= C1.Web.UI.Controls.C1Editor;
using MyEditor = MyProject.Objects.C1Editor;
C1Editor wm1;
MyEditor wm2;

If you use the Imports statement without an alias, you can use all the names in that namespace without 
qualification provided they are unique to the project.

Creating an AJAX-Enabled ASP.NET Project
ComponentOne Editor for ASP.NET AJAX requires you to create an ASP.NET AJAX-Enabled project so that 
Microsoft ASP.NET AJAX Extensions and a ScriptManager control are included in your project before the 
C1Editor control is placed on the page. This allows you to take advantage of ASP.NET AJAX and certain features 
such as partial-page rendering and client-script functionality of the Microsoft AJAX Library.

When creating AJAX-Enabled ASP.NET projects, Visual Studios 2008 and 2005 both give you the option of 
creating a Web site project or a Web application project. MSDN provides detailed information on why you would 
choose one option over the other.

If you are using Visual Studio 2008 with .NET Framework 2.0 or .NET Framework 3.0 or if you are using Visual 
Studio 2005, you must install the ASP.NET AJAX Extensions 1.0, which can be found at http://ajax.asp.net/. 
Additionally for Visual Studio 2005 users, creating a Web application project requires installation of a Visual 
Studio 2005 update and add-in, which can be found at http://msdn.microsoft.com/; however, if you have Visual 
Studio 2005 SP1, Web application project support is included and a separate download is not required. 

If you are using Visual Studio 2008 and .NET Framework 3.5, you can easily create an AJAX-enabled ASP.NET 
project without installing separate add-ins because the framework has a built-in AJAX library and controls. 

Note: If you are using Visual Studio 2010, see http://www.asp.net/ajax/ for more information on creating an AJAX-

Enabled ASP.NET Project.

The following table summarizes the installations needed:

http://msdn.microsoft.com/en-us/default.aspx
http://ajax.asp.net/
http://msdn.microsoft.com/
http://www.asp.net/ajax/
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Visual Studio Version Additional Installation Requirements

Visual Studio 2008, .NET Framework 3.5 None

Visual Studio 2008 and .NET Framework 2.0 or 
3.0

Visual Studio 2005 Service Pack 1

ASP.NET AJAX Extensions 1.0

http://www.asp.net/ajax/downloads/archive/

Visual Studio 2005 ASP.NET AJAX Extensions 1.0

Visual Studio update and add-in (2 installs for 
Web application project support)

The following topics explain how to create both types of projects in Visual Studio 2008 and 2005.

 Creating an AJAX-Enabled Web Site Project in Visual Studio 2008 

To create a Web site project in Visual Studio 2008, complete the following steps:

1. From the File menu, select New | Web Site. The New Web Site dialog box opens.

2. Select .NET Framework 3.5 or the desired framework in the upper right corner. Note that if you choose 
.NET Framework 2.0 or 3.0, you must install the extensions first.

3. In the list of templates, select AJAX 1.0-Enabled ASP.NET 2.0 Web Site.

4. Click Browse to specify a location and then click OK. 

Note: The Web server must have IIS version 6 or later and the .NET Framework installed on it. If 
you have IIS on your computer, you can specify http://localhost for the server. 

A new AJAX-Enabled Web Site is created at the root of the Web server you specified. In addition, a 
new Web Forms page called Default.aspx is displayed and a ScriptManager control is placed on the 
form. The ScriptManger is needed to enable certain features of ASP.NET AJAX such as partial-page 
rendering, client-script functionality of the Microsoft AJAX Library, and Web-service calls.

 Creating an AJAX-Enabled Web Application Project in Visual Studio 2008 

To create a new Web application project in Visual Studio 2008, complete the following steps. 

1. From the File menu, select New | Project. The New Project dialog box opens.

2. Select .NET Framework 3.5 or the desired framework in the upper right corner. Note that if you choose 
.NET Framework 2.0 or 3.0, you must install the extensions first.

3. Under Project Types, choose either Visual Basic or Visual C# and then select Web. Note that one of 
these options may be located under Other Languages. 

4. Select AJAX 1.0-Enabled ASP.NET 2.0 Web Application from the list of Templates in the right pane.

5. Enter a URL for your application in the Location field and click OK.

Note: The Web server must have IIS version 6 or later and the .NET Framework installed on it. If 
you have IIS on your computer, you can specify http://localhost for the server. 

http://ajax.asp.net/
http://ajax.asp.net/
http://ajax.asp.net/
http://www.asp.net/ajax/downloads/archive/
http://ajax.asp.net/
http://msdn.microsoft.com/en-us/default.aspx
http://ajax.asp.net/
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A new Web Forms project is created at the root of the Web server you specified. In addition, a new 
Web Forms page called Default.aspx is displayed and a ScriptManager control is placed on the form. 
The ScriptManger is needed to enable certain features of ASP.NET AJAX such as partial-page 
rendering, client-script functionality of the Microsoft AJAX Library, and Web-service calls.

 Creating an AJAX-Enabled Web Site Project in Visual Studio 2005 

To create a Web site project in Visual Studio 2005, complete the following steps:

1. From the File menu in Microsoft Visual Studio .NET, select New Web Site. The New Web Site dialog box 
opens.

2. Select ASP.NET AJAX-Enabled Web Site from the list of Templates.

3. Enter a URL for your site in the Location field and click OK.

Note: The Web server must have IIS version 6 or later and the .NET Framework installed on it. If 
you have IIS on your computer, you can specify http://localhost for the server. 

A new Web Forms project is created at the root of the Web server you specified. In addition, a new 
Web Forms page called Default.aspx is displayed and a ScriptManager control is placed on the form. 
The ScriptManger is needed to enable certain features of ASP.NET AJAX such as partial-page 
rendering, client-script functionality of the Microsoft AJAX Library, and Web-service calls.

 Creating an AJAX-Enabled Web Application Project in Visual Studio 2005 

To create a new Web application project in Visual Studio 2005, complete the following steps. 

1. From the File menu in Microsoft Visual Studio 2005, select New Project. The New Project dialog box 
opens.

2. Under Project Types, choose either Visual Basic Projects or Visual C# Projects. Note that one of these 
options may be located under Other Languages. 

3. Select ASP.NET AJAX-Enabled Web Application from the list of Templates in the right pane.

4. Enter a URL for your application in the Location field and click OK.

Note: The Web server must have IIS version 6 or later and the .NET Framework installed on it. If 
you have IIS on your computer, you can specify http://localhost for the server. 

A new Web Forms project is created at the root of the Web server you specified. In addition, a new 
Web Forms page called Default.aspx is displayed and a ScriptManager control is placed on the form. 
The ScriptManger is needed to enable certain features of ASP.NET AJAX such as partial-page 
rendering, client-script functionality of the Microsoft AJAX Library, and Web-service calls.

Adding the ASP.NET Components to a Project
When you install ComponentOne Studio for ASP.NET, the Create a ComponentOne Visual Studio Toolbox Tab
check box is checked, by default, in the installation wizard. When you open Visual Studio 2005, you will notice a 
ComponentOne Studio for ASP.NET Projects tab containing the ComponentOne controls that have automatically 
been added to the Toolbox.

If you decide to uncheck the Create a ComponentOne Visual Studio 2005 Toolbox Tab check box during 
installation, you can manually add ComponentOne controls to the Toolbox at a later time. 

Manually Adding the Studio for ASP.NET controls to the Toolbox
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When you install ComponentOne Studio for ASP.NET, the C1Editor component will appear in the Visual Studio 
Toolbox customization dialog box.

To manually add the Studio for ASP.NET controls to the Visual Studio Toolbox:

1. Open the Visual Studio IDE (Microsoft Development Environment). Make sure the Toolbox is visible 
(select Toolbox in the View menu if necessary) and right-click it to open the context menu.

2. To make the Studio for ASP.NET components appear on their own tab in the Toolbox, select Add Tab
from the context menu and type in the tab name, Studio for ASP.NET, for example.

3. Right-click the tab where the component is to appear and select Choose Items from the context menu. 

The Choose Toolbox Items dialog box opens.

4. In the dialog box, select the .NET Framework Components tab. Sort the list by Namespace (click the 
Namespace column header) and check the check boxes for all components belonging to namespace 
C1.Web.UI.Controls.2.dll. Note that there may be more than one component for each namespace.

5. Click OK to close the dialog box.

The controls are added to the Visual Studio Toolbox.

Adding Studio for ASP.NET Controls to the Form

To add Studio for ASP.NET controls to a form:

1. Add them to the Visual Studio toolbox. 

2. Double-click each control or drag it onto your form.

Adding a Reference to the Assembly

To add a reference to the C1.Web. UI.Conttrols.2 assembly:

1. Select the Add Reference option from the Website menu of your Web Site project or from the Project 
menu of your Web Application project. 

2. Select the most recent version of the ComponentOne Studio for ASP.NET assembly from the list on the 
NET tab or browse to find the C1.Web.UI.Controls.2.dll file and click OK.

3. Select the Form1.vb tab or go to View|Code to open the Code Editor. At the top of the file, add the 
following Imports directive (using in C#):
Imports C1.Web.UI.Controls

Note: This makes the objects defined in the C1.Web.UI.Controls.2 assembly visible to the project. See 
Namespaces (page 12) for more information.

Key Features
Some of the key features of ComponentOne Editor for ASP.NET AJAX that you may find useful include:

 Microsoft Office 2007-style Interface

Editor for ASP.NET AJAX implements an Office 2007-style ribbon interface. The ribbon organizes 
related commands under a series of tabs, enabling users to easily explore the editor's functions without 
forcing them to navigate through a hierarchy of menus.
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 Built-in spell checker 

Spell-checking functionality is provided by the built-in spell checker: with just a click of the spell-check 
button, end users can check their entire document for spelling errors.

 Multi-language support

The integrated spell checker supports multiple languages including: English, Dutch, French, German, 
Italian, Portuguese, and Spanish.

 Customize dictionary files with incredible ease

Create and maintain dictionary files (.dct) with the C1SpellChecker Dictionary Editor – add words to the 
main dictionary or create new dictionaries.

 Change the editor's visual style through the SmartTag

With just a click of the SmartTag, change the editor's visual style by selecting one of the C1Editor control's 
five built-in visual styles. Choose from Office 2007 Black, Office 2007 Blue, Office 2007 Silver, Arctic Fox, 
and Vista. See Built-In Visual Styles (page 25) for more information.

 Create custom visual styles

Easily add custom visual styles to the C1Editor control by creating a custom CSS stylesheet and including 
it in your project. Match the editor to your company's current Web site design or create an entirely new 
scheme to suit your personal style – with Editor for ASP.NET AJAX, the design is in your hands.  See 
Custom Visual Styles (page 27) for more information.

 Ability to choose Document Object Model (DOM) node using the path selector

The path selector shows the HTML tag hierarchy at the current cursor position. Select a tag within the 
path selector to alter the scope of the selection. For example, click the <body> element in the path selector 
to select all of the nodes in the editor.

 More advanced formatting features than the standard TextBox control

The editor provides advanced formatting features such as size, color, style, bold, and italic. Additional 
advanced formatting includes alignment, indentation, and bullet lists.

 Clipboard support through keyboard shortcuts

The editor provides keyboard shortcuts to quickly edit text; for example, use the CTRL+C key 
combination to copy text.

 Cross-browser compatibility

Supports multiple browsers, including Internet Explorer, Firefox, and Safari.



18

Editor for ASP.NET AJAX Quick Start
The Editor for ASP.NET AJAX quick start will lead you through the creation of a Web form that uses the 
C1Editor control. In the following steps, you will add the C1Editor control to your project, customize the control's 
appearance using the designer, and run the application. To begin, create a new ASP.NET AJAX-Enabled Web 
Site and complete the following steps:

Step 1 of 3: Adding the C1Editor Control to a Project
In the first step of this quick start, you will create an ASP.NET AJAX-Enabled Web Site project and add a 
C1Editor control to the Web page.

1. Create an ASP.NET AJAX-Enabled Web Site (for more information, see Creating an AJAX-Enabled 
ASP.NET Project (page 13)).

Note: If you are working in Visual Studio 2005, a ScriptManager control will appear on your page in 
default. In Visual Studio 2008, you will have to manually add it from the Visual Studio 2008 Toolbox.

2. Click the Design tab to enter Design view.

3. In the Toolbox, double-click C1Editor.  

A C1Editor control appears in your project.
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Step 1 of 3 Completed 

You have successfully completed step 1 of 3 of the Editor for ASP.NET AJAX quick start. In the next step, you 
will customize the appearance of the C1Editor control in Design view.

Step 2 of 3: Customizing the Appearance of the C1Editor Control
In the last step of this quick start, you created an ASP.NET AJAX-Enabled Web site and added the C1Editor
control to your project. In this step, you will customize the appearance of the C1Editor control in Design view.

1. Right-click the C1Editor control to open its context menu. Select Properties. 
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The Properties window opens with C1Editor''s properties in focus.

2. In the Properties window, complete the following tasks:

 Set the Height property to "250px".

 Set the Width property to "620px".

 Set the VisualStyle property to Office2007Black.

Step 2 of 3 Completed 

You have successfully completed step 2 of 3 of the Editor for ASP.NET AJAX quick start. In the next step, you 
will build the project and sample a few of C1Editor''s run-time features.

Step 3 of 3: Using the C1Editor Control at Run Time
In the last step of this quick start, you customized the appearance of the C1Editor control. In this step, you will run 
your project and explore several of C1Editor''s run-time features.

1. Press F5 to build the project. At run time, C1Editor resembles the following image:
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2. Copy the following text and paste it into C1Editor''s text editor:

ComponentOne Editor for ASP.NET AJAX is easy to use for developers and 
users alike. It even has a spell chekker!

3. Edit the text by completing the following steps:

a. Select "ComponentOne Editor for ASP.NET AJAX" and then click the Bold button .  

b. Select "and" and then click the Italic button .  

c. Select "spell chekker" and then click the Underline button . 

4. Click the Spelling button to initialize a spell check.

C1Editor performs the spell check and an alert box opens, stating that the spell checker has "Found 1 
error(s)".

5. Press OK to close the alert box.

The Spell Checker dialog box opens and recommends that you replace the word "chekker" with 
"checker".
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6. Press Change to replace the misspelled word ("chekker") with the correct word ("checker").

An alert box opens to inform you that the spell check is complete.  

7. Press OK to close the alert box.

The Spell Checker dialog box also closes.

8. Click the Insert tab.

9. Place your cursor after the text and then click the Insert Horizontal Line button .

A horizontal line appears beneath the text.  

10. Click the Insert Date and Time button .

The current date appears beneath the horizontal rule.

Step 3 of 3 Completed

Congratulations! You have successfully completed all three steps of the Editor for ASP.NET AJAX quick start. In 
this quick start, you have added a C1Editor control to your project, edited its appearance, and learned how to use 
several of its run-time features. Your completed project will resemble the following image:



23

Top Tips
This section provides tips and tricks for using the C1Editor control. 

 Remember to always use the ScriptManager control.

 Set visual styles on your Studio for ASP.NET control to add rich themes to your application. For task-
based help, see Changing the Built-In Visual Style (page 60). For a list of visual styles, see Built-In Visual 
Styles (page 25). 

 Use image sprites in your custom visual styles to increase performance and decrease load times. 

 Update the client-side model properties and events when you don't need to perform server-side processing. 
The C1Editor control can be coded on both the client side and server side.

 Use the ShowSpellCheckerDialog property to indicate whether to show the spell checker dialog box or to
just allow a user to select suggestions from acontext menu.

The following code sets the ShowSpellCheckerDialog property to show the spell checker dialog box:

o Visual Basic
Me.C1Editor1.ShowSpellCheckerDialog = true

o C#
this.C1Editor1.ShowSpellCheckerDialog = true;

For task-based help, see Replacing the Spell Checker Dialog Box with a Context Menu (page 64). For 
conceptual information, see C1Editor Run-Time Context Menu (page 52).

 Use the DialogUploadFolder property to set the virtual path of the folder where the C1Editor control will 
automatically save valid files after the file upload of a dialog box completes.

For example:

o Visual Basic
Me.C1Editor1.DialogUploadFolder = "~/CustomFolder";

o C#
this.C1Editor1.DialogUploadFolder = "~/CustomFolder";
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 Use the DictionaryPath property to set the path of the spell checker dictionary.

When the DictionaryPath property is set to empty, the C1Editor control will automatically save the 
default dictionary to system directory.

The following code sets the DictionaryPath property to a custom dictionary path.:

o Visual Basic
Me.C1Editor1.DictionaryPath = "~/Dictionaries/C1Spell_de-DE.dct"

o C#
this.C1Editor1.DictionaryPath = "~/Dictionaries/C1Spell_de-DE.dct";

 Use the RibbonUI property to customize the C1Editor control at run-time.

For example:

o Visual Basic
Protected Sub Page_Load(ByVal sender As Object, ByVal e As EventArgs)

'Remove the original 'Format' page. 
Me.C1Editor1.RibbonUI.TabPages.Remove(C1.Web.UI.Controls.C1Editor.C1Edit
orConst.Page_Format)
'Remove the 'Special' group of 'Insert' page.            
Me.C1Editor1.RibbonUI.TabPages(C1.Web.UI.Controls.C1Editor.C1EditorConst
.Page_Insert).Groups.Remove(C1.Web.UI.Controls.C1Editor.C1EditorConst.Gr
oup_Special)'Remove 'Table' toolbar in 'Table' group of the 'Insert' 
page.        
Me.C1Editor1.RibbonUI.TabPages(C1.Web.UI.Controls.C1Editor.C1EditorConst
.Page_Insert).Groups(C1.Web.UI.Controls.C1Editor.C1EditorConst.Group_Tab
les).ToolBars.Remove(C1.Web.UI.Controls.C1Editor.C1EditorConst.Toolbar_T
able)

'Remove first item of 'Table' toolbar in 'Table' group of the 'Insert' 
page.        
Me.C1Editor1.RibbonUI.TabPages(C1.Web.UI.Controls.C1Editor.C1EditorConst
.Page_Insert).Groups(C1.Web.UI.Controls.C1Editor.C1EditorConst.Group_Tab
les).ToolBars(C1.Web.UI.Controls.C1Editor.C1EditorConst.Toolbar_EditTabl
e).Items.RemoveAt(0)
End Sub

o C#
protected void Page_Load(object sender, EventArgs e)
{
//Remove the original 'Format' page.
        
this.C1Editor1.RibbonUI.TabPages.Remove(C1.Web.UI.Controls.C1Editor.C1Ed
itorConst.Page_Format);

//Remove the 'Special' group of 'Insert' page.           
this.C1Editor1.RibbonUI.TabPages[C1.Web.UI.Controls.C1Editor.C1EditorCon
st.Page_Insert].Groups.Remove(C1.Web.UI.Controls.C1Editor.C1EditorConst.
Group_Special);

//Remove 'Table' toolbar in 'Table' group of the 'Insert' page.        
this.C1Editor1.RibbonUI.TabPages[C1.Web.UI.Controls.C1Editor.C1EditorCon
st.Page_Insert].Groups[C1.Web.UI.Controls.C1Editor.C1EditorConst.Group_T
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ables].ToolBars.Remove(C1.Web.UI.Controls.C1Editor.C1EditorConst.Toolbar
_Table);
        
//Remove first item of 'Table' toolbar in 'Table' group of the 'Insert' 
page.        
this.C1Editor1.RibbonUI.TabPages[C1.Web.UI.Controls.C1Editor.C1EditorCon
st.Page_Insert].Groups[C1.Web.UI.Controls.C1Editor.C1EditorConst.Group_T
ables].ToolBars[C1.Web.UI.Controls.C1Editor.C1EditorConst.Toolbar_EditTa
ble].Items.RemoveAt(0);
}

C1Editor Appearance
The C1Editor control features several ways to customize the appearance of the editor. The following topics provide 
information about styling the C1Editor control.

Built-In Visual Styles
Editor for ASP.NET AJAX features five built-in visual styles: ArcticFox, Office2007Black, Office2007Blue, 
Office2007Silver, and Vista. You can fully style the C1Editor control by setting the VisualStyle property.  

The following images illustrate the C1Editor control's five built-in visual styles:

ArcticFox

The following image illustrates the ArcticFox visual style:

Office2007Black

The following image illustrates the Office2007Black visual style:
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Office2007Blue

The following image illustrates the Office2007Blue visual style:

Office2007Silver

The following image illustrates the Office2007Silver visual style:
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Vista

The following image illustrates the Vista visual style:

Changing a Visual Style

To change a visual style, click C1Editor''s smart tag ( ) to open the C1Editor Tasks menu, click the VisualStyle
drop-down arrow, and select a style from the list.

To learn other methods of changing the visual style, see Changing the Built-In Visual Style (page 60).

Custom Visual Styles
While Editor for ASP.NET AJAX comes with five built-in visual styles, we recognize that there are instances 
where that you will want to customize your C1Editor control. To customize the C1Editor control, you will create a 
custom CSS style sheet and add it to your project as a visual style. The custom CSS stylesheet must always be 
named "styles.css".

Tip: The easiest way to create a custom visual style is by modifying one of the control's pre-existing visual 
styles. You can find the .css sheets and images for C1Editor's visual styles within the installation directory at 
C:\Program Files\ComponentOne\Studio for ASP.NET\C1WebUI\VisualStyles.
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Before you add your .css file and images, you will have to create a hierarchy of folders, the last of which will hold 
your files. On the top-level of your project, create a folder named "VisualStyles". Underneath the VisualStyles 
folder, create a sub-folder bearing the theme name (such as "CustomStyle"), and then, beneath that, create a sub-
folder named "C1Editor". The image folder and .css file should be placed underneath the C1Editor folder. The 
result will resemble the following:

This structure of these folders is very important; C1Editor will always look for the 
~/VisualStyles/StyleName/C1Editor/styles.css path, as it is the default visual style path for the control.

Once the .css file and image are in place, set the VisualStylePath property to the path of the first folder 
(~/VisualStyles), set the UseEmbeddedVisualStyles property to False, and then set the VisualStyle property to the 
custom theme name. 

Design-Time Support
The following topics describe how to use C1Editor''s design-time environment to configure the C1Editor control.

Smart Tag
The C1Editor control includes a smart tag in Visual Studio. A smart tag represents a short-cut tasks menu that 
provides the most commonly used properties in C1Editor.

To access the C1Editor Tasks menu, click on the smart tag in the upper-right corner of the C1Editor control. This 
will open the C1Editor Tasks menu.

The C1Editor Tasks menu operates as follows:

 VisualStylePath

Sets the path to the built-in or custom visual style.

 UseEmbeddedVisualStyles

When selected, this forces the control to use a built-in visual style. When unselected, the control will shed 
its built-in visual style and you will have to add a custom style.

 Visual Style
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Selecting a VisualStyle from the drop-down list changes the visual scheme of the control.

 About

Clicking About reveals the About ComponentOne dialog box. This dialog box displays the version 
number and licensing information for the ComponentOne product.

Context Menu
C1Editor has additional commands available on the context menu that Visual Studio provides for all .NET and 
ASP.NET controls.

Right-click anywhere on the C1Editor control to display the context menu:

The C1Editor context menu operates as follows:

 Show Smart Tag

Clicking Show Smart Tag opens the C1Editor Tasks menu.

C1Editor Run-Time Elements
The following topics provide information regarding the run-time environment of the C1Editor control.

User Interface Elements
The C1Editor control's user interface consists of the following four areas:

 Ribbon

 Text Editor

 PathSelector

 Toolbar

The following diagram illustrates the different areas of the C1Editor control.
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The following topics summarize the features and functions provided by each element of the C1Editor control.

Ribbon

The C1Editor control's ribbon interface enables users to explore commands without forcing them to navigate
through a hierarchy of menus. The ribbon interface is a tabbed panel that contains interface elements, such as 
buttons and drop-down lists. These interface elements are collected into groups of interrelated or affiliated 
commands, which are then arranged into a series of tabs to consolidate similar editor tasks. 

The following image depicts the C1Editor ribbon interface:

C1Editor''s ribbon contains two tabs: Format and Insert. The tabs and their groups of commands are detailed in 
the following topics.

Format Tab

The Format tab contains groups of commands that can be used to format the contents of the text editor. 
Underneath the Format tab are four groups – Actions, Font, Paragraph, and Review – that house closely related 
tasks.  

The following graphic shows the groups and buttons associated with the Format tab:
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The following sections detail the commands of each group:

Actions Group

Commands within the Action group can be used to perform common actions, such as saving a document or 
undoing a previous action. The following table details the commands of the Action group:

Button Name Description

Save Raises a postback to the Web server where your application 
retrieves content from the C1Editor control using the Text property. 
The control then performs actions consistent with saving the user's 
changes.

Undo Erases the most recently performed operation done to the 
document, except another Undo, reverting it back to an older state. 
To reverse the Undo operation, use the Redo command.

Redo
Reverses the Undo command or advances the buffer to a more 
current state.

Preview Opens the print Preview dialog box (see Preview Dialog Box (page 
47)), allowing users to select a preview window size and print 
C1Editor content.

Clean Up Opens the Cleanup Source HTML Document dialog box (see 
Cleanup Source HTML Document Dialog Box (page 39)), which 
allows users to remove Microsoft Word tags from their document.

Cut Removes the original source text and places it on the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard.

Select All Selects all content in the text window.

Font Group

Commands under the Font group can be used to manipulate font settings. The following table details the 
commands of the Font group:

Button Name Description

Font Name
Allows you to choose a Font style. The Font drop-down list includes 
the following fonts: Arial, Courier New, Garamond, Tahoma, 
Times, Verdana, Wingdings.

Font Size
Changes the size of the text. The Size combo box includes the 
following sizes: Very Small, Smaller, Small, Medium, Large, 
Larger, Very Large.

Background Color Displays the Set BackColor dialog box (see Set BackColor Dialog 
Box (page 48)), from which the user can select a background 
color. The coloring can apply to subsequent input or a selected 
range of text. 

Font Color Displays the Set ForeColor dialog box (See Set ForeColor Dialog 
Box (page 49)), from which the user can select a text color. The 
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coloring can apply to subsequent output or to the selected range
of text.

Bold
Emphasizes text by making text darker than the surrounding text
using the <strong> tag.

Italic
Emphasizes text by applying italicized formatting using the <em> 
tag.

Underline Adds a line beneath the text using the <u> tag.

Strikethrough
Adds a horizontal line through the center of the text using the 
<strike> tag.

Subscript Makes text appear smaller than the normal line of type and sets 
text slightly below the baseline using the <sub> tag.

Superscript Makes text appear smaller than the normal line of type and sets 
text slightly above the baseline using the <sup> tag.

Format Opens the Apply Template dialog box (see Apply Template 
Dialog Box (page 38)), from where users can add, delete, and 
save templates.

Remove Format Removes the format of the currently selected text.

Paragraph

Commands within the Paragraph group can be used to manipulate paragraph settings. The following table details 
the commands of the Paragraph group:

Button Name Description

Justify Left Aligns text to the left side of the page, causing the text to be flush 
with the left margin; however, the text will appear jagged on the 
right side.

Justify Center Aligns to text to the center of the page. Lines of text are placed 
equidistant from the left and right margins.

Justify Right Aligns text to the right side of the page, causing the text to be flush 
with the right margin.

Justify Full Aligns text to both the right and left margin. Text that is fully 
justified is smooth along both margins, but the words spread out to 
fill the space between. This type of formatting is subject to Web 
browser support.

Border Applies a border to the currently selected text.

Numbered List Formats the text into an ordered list. An ordered list (numeric or 
alpha-numeric) indicates that the sequence of list items is 
significant. 

Bulleted List Formats the text into an unordered list. An unordered list ( or 
bulleted list) indicates that the sequence of list items is insignificant.

Outdent
Places text back to the left again. This formatting only applies if the 
text content was previously indented.

Indent
Places text farther to the right to separate it from surrounding text.

Review Group

Commands under the Review group can be used to review current documents. The following table details the 
commands of the Review group:

Button Name Description

Spelling Activates a spell check for the current document. See Spell Checker 
Dialog Box (page 50) for more details.

Inspect Opens the Tag Inspector dialog box. See Tag Inspector Dialog Box
(page 50) for more details.
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Find Opens the Find and Replace dialog box, from where users can 
search for specific strings and, if they desire, replace those strings.

Insert Tab

The Insert tab contains groups of commands that enable end-users to insert items, such as images or paragraph
breaks, into the text editor. Underneath the Format tab are four groups – Tables, Breaks, Forms, and Special –
that house closely related tasks.

The following graphic shows the groups and buttons associated with the Insert tab:

The following sections detail the commands of each group:

Table Group

Commands under the Table group can be used to add and manipulate tables. The following table details the 
commands of the Table group:

Button Name Description

Table Clicking the drop-down arrow will allow you to choose between 
inserting a table and editing a pre-existing one. See Insert 
Table/Edit Table Dialog Boxes (page 45) for more details.

Insert Column
Inserts a column in a table. This formatting only applies if the table 
was added.

Insert Row
Inserts a row in a table. This formatting only applies if the table was 
added.

Insert Cell
Inserts a cell in a table. This formatting only applies if the table was 
added.

Delete Row
Deletes the row at the current cursor position. This formatting only 
applies if a row was previously added.

Delete Column Deletes the column at the current caret position. This formatting 
only applies if a column was previously added.

Delete Cell
Deletes the cell at the current cursor position. This formatting only 
applies if a cell was previously added.

Split Cell Splits a cell into two cells in a table. This formatting only applies if a 
table has been added to the document.

Merge Cell Merges two cells in a table. This formatting only applies if a table 
has been added to the document.

Breaks Group

Commands under the Breaks group can be used to add different types of breaks to a document. The following 
table details the commands of the Breaks group:

Button Name Description
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Insert Break Inserts a line break at the current cursor position in the document.

Insert Paragraph Break Inserts a paragraph at the current cursor position in the document.

Insert Print Page Break Inserts a page break at the current cursor position in the document. 
The content below the page break will be printed on a separate 
page.

Insert Horizontal Line Inserts a horizontal rule at the current cursor position in the 
document.

Forms Group

Commands under the Forms group can be used to add different types of form controls to a document. The 
following table details the commands of the Forms group:

Button Name Description

Form Inserts a <form> tag.

Text Area Inserts a text area four rows tall.

Text Box Inserts a text box. The height and width are adjustable.

Password Field Inserts a password field input box. Any information entered in this 
box will be replaced with asterisks.

Image Button
Inserts an <IMG> tag. SRC attribute can be edited in the source code 
editing mode.

Button Inserts a button at the current cursor point.

List Box Inserts a list box. The height and width are adjustable.

Drop-Down List Inserts a drop-down box. The width is adjustable.

Radio Button Inserts a radio box with a label.

Check Box Inserts a check box with a label.

Special Group

Commands under the Special group can be used to add links and multimedia items to a document. The following 
table details the commands of the Special group:

Button Name Description

Link Opens the Insert Hyperlink dialog box (see Insert Hyperlink Dialog 
Box (page 41)) allowing users to insert a URL for the hyperlink, view 
the HTML code for the hyperlink, and enter CSS text to apply a style 
to inspected DOM elements. 

Image Browser Opens the Insert Image dialog box or Edit Image dialog box (see 
Insert Image/Edit Image Dialog Boxes (page 42)) where users can 
specify the image source, alternate text for the image, image height 
and width, and enter CSS text to apply a style to inspected DOM 
elements.

Media Opens the Insert Media dialog box (see Insert Media Dialog Box
(page 44)), where users can specify the media source, alternate text, 
width, and height.

Insert Special 
Character

Opens the Insert Special Character dialog box (see Insert Special 
Character Dialog Box (page 44)) allowing users to insert special 
characters and symbols such as  or .

Insert Date and Time Inserts the current date and time at the current cursor position.

Text Editor

The C1Editor control's text editor is used to compose rich text. You can set the text editor to one of the following 
three views:



35

 Design View

This view displays the text editor's content in a What-You-See-Is-What-You-Get (WYSIWYG) format. It 
provides a real-time simulation of how the content will appear when published or printed. 

The following image shows the text editor in Design view:

 Source View

This view provides a hand-coding environment for writing and editing HTML. While Source view is 
commonly used by those who want to manually enter HTML markup, users can still use the ribbon 
interface to apply HTML tags to the content in this view.

The following image shows the text editor in Source view:
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 Split View

This view displays both the Design view and Source view in the text editor. When this view is invoked, 
the editor splits the text editor into two vertical sections; the top section features the Design view, while 
the bottom section features the Source view. This view is useful because you can see an immediate 
preview of the content as you edit the markup.

The following image shows the text editor in Split view:
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You can set the initial run-time view of the text editor by setting the EditorMode property at design time. The 
EditorMode property can be set to one of three settings: WYSIWYG (Design View), Split (Split View), and Code 
(Source view). End-users can also select a view at run time using the toolbar at the bottom of the editor (see 
Toolbar (page 37)).

Scrollbars will automatically appear if content added to the text editor exceeds the available screen space.

Path Selector

The path selector displays the HTML tag hierarchy at the current cursor position. The currently selected tag will be 
highlighted in yellow.

The following image highlights C1Editor's path selector:

Users can select a tag within the path selector to alter the scope of their selection. For example, envision that the 
path selector is currently showing three tags: <body>, <p>, and <u>. <u>, which is highlighted in yellow, marks 
the current selection, which is an underlined word in a paragraph. If you select <p>, the selection will encompass 
the entire paragraph; if you select <body>, the entire page will be selected.

Toolbar

Using the toolbar, end-users can toggle views and enable text wrapping at run time. It features five buttons –
Design View, Source View, Split View, Word Wrap, and Full Screen – which are detailed in the table below.
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Button Name Description

Design View Clicking the Design View button switches the text editor to Design 
View, where users can view a real-time preview of their content. For 
more information on Design View, see Text Editor (page 34).

Source View Clicking the Source View button switches the text editor to Source 
View, where users can write their own HTML markup. For more 
information on Source View, see Text Editor (page 34).

Split View Clicking the Split View button switches the text editor to Split View, 
where users can see both Design View and Source View within the text 
editor window. For more information on Split View, see Text Editor
(page 34).

Word Wrap 
Clicking the Word Wrap button inserts soft returns on the right margin 
of the source code document. When this feature is enabled, users can 
view and edit HTML without having to perform any left-to-right scrolling. 
This feature is not available in Design View.

Full Screen
Clicking the Full Screen button toggles the editor between full-screen 
view and partial-screen view.

The following image highlights C1Editor's toolbar:

Editor Dialog Boxes
Within the C1Editor control are several dialogue boxes that users can employ to create and edit C1Editor
documents. The following topics detail the dialog boxes that can be accessed through the C1Editor control.

Apply Template Dialog Box

In the Apply Template dialog box, users can select, add, and delete templates for their documents. To access the 

Find and Replace dialog box, click C1Editor''s Format tab and then click the Format button . 
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To use an existing template in a document, select a template from the Select Template box and click Apply. 

To delete an existing template, select the template from the Select Template box and click Delete Selected.

To save the current page as a template, fill out the Name and Description fields and press Save Current Page as 
Template.

Cleanup Source HTML Document Dialog Box

In the Cleanup Source HTML Document dialog box, users can strip (or, in some instances, replace) unnecessary 
tags and symbols from their source HTML documents. To access the Cleanup Source HTML Document dialog 

box, click C1Editor''s Format tab and then click the Clean Up button .
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The Document Source pane provides a preview of the source HTML document. Beneath the Document Source
pane is a series of check boxes, each denoting a different HTML element that can be either be modified or stripped 
from the source document. 

To modify or strip source markup, select a check box and click OK. The Cleanup Source HTML Document
dialog box will close and the selected element will be modified in the document's source.

Find and Replace Dialog Box

In the Find and Replace dialog box, users can find text and, if they choose, replace it with other text. To access the 

Find and Replace dialog box, click the C1Editor''s Format tab and then click the Find button .
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To find specific text, enter the text in the Find text box and click Find.

To replace specific text, enter the text to be replaced in the Find text box, enter the text to replace it in the Replace
text box, and then click Replace.

Insert Hyperlink Dialog Box

In the Insert Hyperlink dialog box, users can insert hyperlinks into their documents. To open the Insert Hyperlink 
dialog box, select the Insert tab and click the Link button.
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The following table details the elements of the Insert Hyperlink dialog box:

Element Description

Address field The path to the link.

Radio buttons The radio buttons in the Insert Hyperlink dialog box allow you to choose 
from four link types: url, anchor, e-mail, and local file. When anchor is 
chosen, a drop-down list activates, allowing you to select the anchor name 
from a list.

Text to Display field The text that will be displayed as a link.

Target drop-down list The target is the area where the link will open into. You can choose from 
four areas: _blank, _parent, _self, and _top.

Css The name of the CSS style, if any, to apply to the hyperlink.

Browse button The Browse button opens the Choose File dialog box, which allows you 
to select a file on your hard drive to link to. 

Upload button The Upload button will upload the file that you chose in the Choose File
dialog box to the ~/DialogUploadFolder directory.

Insert Image/Edit Image Dialog Boxes

The Insert Image dialog box and Edit Image dialog box, which are nearly identical in appearance and function, 

are both accessed by clicking the Image Browser button . The Insert Image dialog box appears if you click the 
Image Browser button when no image is selected, while the Edit Image dialog box appears if you click the Image 
Browser button while an image is selected in C1Editor's text editor.

The following five elements are present in the Insert Image / Edit Image dialog boxes:

 Select Image box

 Preview box
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 Image Information section

 Edit Image section

 Upload Image section

The following image diagrams the different sections of the Insert Image and Edit Image dialog boxes:

The Select Image section, which is at the top-left of the dialog box, features a list of images. Users can select an 
image to preview from that list.

The Preview box, which is at the top-right of the dialog box, features a preview of the selected image. 

The Image Information section, which is in the middle of the dialog box, features image information, such as the 
size and the resolution of the image. 

The Edit Image section, which lies between the Image Information Section and the Upload Image section, allows 
users to add and/or alter the information for the image. Users can add information to the following fields:
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Name Description

Image Src The URL path of the image.

Image alt text The text that will display if, for some reason, the image cannot be shown.

Image width The width of the image in pixels.

Image height The height of the image in pixels.

Css Text The name of the CSS style, if any, to apply to the graphic.

The Upload Image section, which sits at the bottom of the dialog box, allows users to browse their hard drive for 
an image to add to the project. To locate an image, click Browse. To add that image to the Select Image box, press 
Upload.

Insert Media Dialog Box

The Insert Media dialog box allows users to insert media files into their documents. To open the Insert Media

dialog box, click the Insert tab and then click the Insert Media button .

The following table details the elements of the Insert Media dialog box:

Name Description

Media Type Allows you to select from four different media types: flash, video, applet, and other.

Media Url The URL path to the media file.

Image width The width of the media file.

Image height The height of the media file.

Insert Special Character Dialog Box

In the Insert Special Character dialog box, users can insert special characters into their documents. To open the 

Insert Special Character dialog box, click the Insert tab and then click the Insert Special Character button .
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On the left side of the Insert Special Character dialog box is a preview window where users can preview the 
special character and its name. On the right side of the Insert Special Character dialog box is a list of special 
characters broken into three sections: Punctuation, Symbols, and Diacritics.

To preview a special character, hover over it with your cursor. An enlarged image of the special character and the 
name of the special character will appear in the preview window.

To select a special character and insert it into your document, simply click on it.

Insert Table/Edit Table Dialog Boxes

The Insert Table and Edit Table dialog boxes are nearly identical in appearance, but the function of each dialog 
box is slightly different. The Insert Table dialog box adds a table to a document, whereas the Edit Table dialog 
box can only be used to edit a pre-existing table. Each dialog box holds the same input fields, each of which 
provides the ability to adjust the attributes of a table without using code. 

To open the Insert Table dialog box, click the Insert tab, click the Table drop-down arrow, and then click Insert.
The Insert Table dialog box opens with all of its fields blank, such as in the following image: 
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To open the Edit Table dialog box, click the Insert tab, select the table, click the Table drop-down arrow, and then 
click Edit.

The Edit Image dialog box opens with the selected table's current specifications already listed in the input fields, 
such as in the following image:
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The following table outlines the fields of the Insert Table and Edit Table dialog boxes:

Field Description

Rows The number of rows in the table.

Columns The number of columns in the table.

Table Width The width of the table in pixels.

Table Height The height of the table in pixels.

Cell Padding The amount of space, in pixels, between the border 
of each cell and that cell's content.

Cell Spacing The amount of space, in pixels, between the cells 
and the table. 

Css Text The CSS style associated with the table.

Background Color The background color of the table. This color can be 
typed in manually or chosen from a dialog box. To 
open the dialog box, click the ellipsis button.

Preview Dialog Box

In the Preview dialog box, users can preview and print their documents. To access the Preview dialog box, click

C1Editor's Format tab and then click the Preview button .
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Before users print their documents, they can see a preview of it within the Preview dialog box. They can choose to 
see the preview in three different resolutions – 640 x 480, 800 x 600, and 1024 x 768 – by selecting radio buttons. 

By default, the Split Pages option is selected. When this is selected, the previewed document is displayed by page; 
users can then change the page they are previewing by pressing the Prev page and Next page buttons. The number 
of the page being previewed, as well as the total amount of pages in the document, is displayed on the page 
indicator, which rests between the Prev page and Next page buttons.

If the Split Pages option is unselected, the will show the entire document will appear in the preview window. 
Please note that the number of the pages in the document will not be displayed if the Split Pages option is turned 
off.

There are two print options in the Preview dialog box: Print Page and Print All. Clicking Print Page will print the 
current page, while clicking Print All will print all pages in the document.

The Preview dialog box can be closed by clicking Close.

Set BackColor Dialog Box

In the Set BackColor dialog box, users can change the background color of a selected piece of text. To access the 

Set BackColor dialog box, click C1Editor's Format tab and then click the Background Color button .
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The first column in the Set BackColor dialog box shows a gradient of colors in one part of the color spectrum, 
which gives users the option to select from different shades of the same color. Users can change the colors in this 
gradient by selecting a color in the rainbow spectrum (the second column). Once a user selects a different part of 
the spectrum, the gradient in the first column will change to reflect the user's choice, and the user can then select a 
background color. The selected color will appear in the window on the far left and its hexadecimal value will be 
revealed in the Selected Color text box. Clicking OK will apply the changes to the document.

Set ForeColor Dialog Box

The Set ForeColor dialog box allows users to change the color of their document background. To access the Set 

ForeColor dialog box, click C1Editor's Format tab and then click the Font Color button .

The first column in the Set ForeColor dialog box shows a gradient of colors in one part of the color spectrum, 
which gives users the option to select from different shades of the same color. Users can change the colors in this 
gradient by selecting a color in the rainbow spectrum (the second column). Once a user selects a different part of 
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the spectrum, the gradient in the first column will change to reflect the user's choice, and the user can then select a 
background color. The selected color will appear in the window on the far left and its hexadecimal value will be 
revealed in the Selected Color text box. Clicking OK will apply the changes to the document.

Spell Checker Dialog Box

The Spell Checker dialog box will only appear if the spell checker has located a misspelling, typo, or a word that 
isn't currently a part of its dictionary. To perform a spell check, select the Format tab and click Spelling. 

There are two dialog boxes and a drop-down list in the Spell Checker dialog box. The Not in Dictionary text box 
features the word being questioned by the spell checker. The Change To text box and the Suggestions drop-down 
list are interrelated. The Change To text box contains the word that will be applied when the user clicks Change or 
Change All, while the Suggestions drop-down list contains other proposals for replacements. Selecting a new 
word from the Suggestions drop-down list will add that word to the Change To text box, replacing the word that 
was there originally.

To change a misspelled word to the suggested change in the Change To dialog box, click Change. To change all 
instances of the misspelled words to the one in the Change To dialog box, click Change All.

In some situations, you may not want to change the word in the Not in Dictionary text box. To ignore the current 
suggestion, click Ignore. To ignore all instances of that suggested word change, click Ignore All.

Tag Inspector Dialog Box

In the Tag Inspector dialog box, users can view and edit HTML attributes without typing their additions or 
changes into the actual HTML markup tag. Users only have access to this feature while working in Design view or 
Split view. 

To access the Tag Inspector dialog box, complete the following:

1. Click the Design View button on C1Editor's toolbar.

In the text editor, place your cursor on the element you want to inspect.

2. Click C1Editor's Format tab and then click the Tag Inspector button .

The Tag Inspector dialog box opens. 
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Once opened, the Tag Inspector dialog box reveals a list of attributes associated with the tag that the user selected. 
For example, a <Font> tag will list attributes such as class, point size, and color, whereas a <TD> tag will list 
attributes such as background color, column span, and row span. Users can change, add, or delete attributes. To 
change or add an attribute, enter information into the attribute's text box, select the Save box, and click OK.

By default, every type of attribute associated with the tag will show, even if that attribute is empty. To hide empty 
attribute boxes from view, select the Display Not Empty Attributes Only box.

The Inner HTML box displays the text nested within the HTML tag. To change this text, simply enter text into the 
box.

The C:\Program Files\ComponentOne\Studio for ASP.NET\C1WebUI\VisualStyles box displays the name of 
the CSS style associated with this HTML tag. If there is no CSS style applied, this box will be empty.

C1Editor Keyboard Shortcuts
The C1Editor control allows users to complete several functions through the use of keyboard shortcuts. The 
following table details the functions that can be accessed through keyboard shortcuts:
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Function Keyboard Shortcut

Copy CTRL+C

Cut CTRL+X

Paste CTRL+V

Select All CTRL+A

Bold CTRL+B

Italicize CTRL+I

Underline CTRL+U

Undo CTRL+Z

Redo CTRL+Y

C1Editor Run-Time Context Menu
The C1Editor control features a run-time context menu that allows users to complete several editing tasks. 
C1Editor''s run-time context menu can be accessed by right-clicking in the text editor.

From the C1Editor run-time context menu, users can cut, copy, or paste selected items in the text editor. They can 
also remove and edit hyperlinks, and they can open the Tag Inspector dialog box (see Tag Inspector Dialog Box
(page 50)) by selecting TagInspector.

C1Editor Spell Checker Context Menu
When C1Editor's ShowSpellCheckerDialog property is set to False, spelling errors will be handled through a 
context menu (see Replacing the Spell Checker Dialog Box with a Context Menu (page 64)). When a misspelled 
word is found, C1Editor will underline the error with a red, dotted line. When a user right-clicks on the misspelled
word, a context menu with options for handling the misspelled word will appear.
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At the top of the context menu is the Skip selection. Press Skip to ignore the misspelled word and to remove the 
red, dotted line from underneath it.

At the bottom of the context menu is the Cancel Spell Check selection. Press Cancel Spell Check to stop the 
current spell check and to remove the red, dotted lines from underneath the misspelled words.

Between the Skip and Cancel Spell Check selections is a list of recommended spellings for the word in question; 
these words will always appear in bold. To change the current word to one of these spellings, simply select a word 
with your cursor.

Client-Side Functionality
The C1Editor control includes a rich and flexible client-side object model. Several server-side properties and 
methods can be used on the client-side. 

When a C1Editor control is added to a web project, an instance of the client-side editor will be created 
automatically. For example, if you have an editor control with the server-side ID of "C1Editor1", you can use the 
following script to acquire a reference to its client object:

var newEditor = $find("<%= C1Editor1.ClientID %>"); 

Using C1Editor''s client-side functionality, you can implement many features in your Web page without causing a 
server postback. Thus, using client-side methods , properties, and events will increase the efficiency of your Web 
site. 

The following topics describe the available client-side properties and methods.

Client-Side Properties
The following conventions are used when accessing the client object properties: 

 Server properties on the client are implemented as a pair of Get- and Set- methods.

 Method names must start with "get_" (Get-method) and "set_" (Set-method) followed with the server 
property name. The first letter of the server property name must be lowercase (camel case).

The following JavaScript sample sets the editor's editing view to WYSIWYG:

<script language="javascript" type="text/javascript">
$find("<%=C1Editor1.ClientID%>").set_editorMode(WYSIWYG);
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</script>

See C1Editor's client-side reference for more information.

Client-Side Methods
C1Editor includes a rich client-side object model in which several properties can be set on the client side. For 
information about these client-side methods and what properties can be set on the client side, see the C1Editor
reference.

Editor for ASP.NET AJAX Samples
Please be advised that this ComponentOne software tool is accompanied by various sample projects and/or demos 
which may make use of other development tools included with the ComponentOne Studios.

You can access samples from the ComponentOne Control Explorer. To view samples, click the Start button and 
then click ComponentOne | Studio for ASP.NET | Control Explorer. The following table provides a short 
overview of each sample.

Sample Description

Editing Modes Provides sample of editor's three editing modes, Source, Split View, and 
WYSIWYG. This sample also shows how to remove the path selector from the 
editor.

HTML Elements Illustrates the editor's HTML elements, such as text inputs, radio buttons, and 
much more.

SpellChecking Demonstrates C1Editor's spell checking functionality. Just press the Spelling 
button to initiate the spell check.

Visual Styles Illustrates the editor's five built-in visual styles.
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3. Press F5 to run the project and run your cursor over the C1Editor control's ribbon or toolbar. Observe that 
a tooltip that says "C1Editor ToolTip" appears as you hover over the control.

Adding a ToolTip in Code

To add a ToolTip, complete the following steps:

1. Add the following code, which sets the ToolTip property, to the Page_Load event.

 Visual Basic
C1Editor1.ToolTip = "C1Editor ToolTip"

 C#
C1Editor1.ToolTip = "C1Editor ToolTip";

2. Press F5 to run the project and run your cursor over the C1Editor control's ribbon or toolbar. Observe 
that a tooltip that says "C1Editor ToolTip" appears as you hover over the control.

This Topic Illustrates the Following:

The result of this topic will resemble the following image:

Changing the Editor Mode
The C1Editor control's editor features three editor modes: Design view, Source view, and Split view. Although 
users can select from each of these views at run time, you can determine which view users will see initially by 
setting the EditorMode property. In this topic, you will learn how to set the EditorMode property in Design view, 
in Source view, and in code.

For more information on editor modes, see Text Editor (page 34).

Changing the Editor Mode in Design View

To change the editor mode, complete the following steps:

1. In Design view, right-click the C1Editor control to open its context menu and select Properties.

The Properties window opens with C1Editor''s properties in focus.
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Note: Please note that this sample changes the editor mode to Split. You can also set this property to 
WYSIWYG or CODE.

3. Press F5 to run the project and observe that C1Editor''s text editor opens in Split view.

Creating a C1Editor Control in Code
In this topic, you will learn how to create a C1Editor control using Visual Basic and C# code.

To create a C1Editor control in code, complete the following steps:

1. In the Visual Studio Toolbox, double-click UpdatePanel to add it to your project.

2. Import the following namespace into your project.

 Visual Basic
Imports C1.Web.UI.Controls.C1Editor

 C#
using C1.Web.UI.Controls.C1Editor;

3. Add the following code to the Page_Load event to create the C1Editor control:

 Visual Basic
Dim NewEditor As New C1Editor() 

 C#
C1Editor NewEditor = new C1Editor();

4. Add the following code to the Page_Load event to add the C1Editor control the UpdatePanel's container:

 Visual Basic
UpdatePanel1.ContentTemplateContainer.Controls.Add(NewEditor) 

 C#
UpdatePanel1.ContentTemplateContainer.Controls.Add(NewEditor);

5. Press F5 to run the project and observe that a C1Editor control appears at run time.

Modifying the Appearance of C1Editor
The following topics illustrate how to change the visual style of a C1Editor control. In one topic, you will learn 
how to change the built-in visual style; in the other, you will learn how to add a customized visual style to the 
C1Editor control.

Adding Custom Visual Styles

You can use the VisualStyle, VisualStylePath, and UseEmbeddedVisualStyles properties to create a custom 
visual style for your C1Editor. This topic assumes that you have created a C1Editor object with at least two tabs.

For more information on custom visual styles, see Custom Visual Styles (page 27).

Adding Custom Visual Styles in Design View
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To add a custom visual style, complete the following steps:

1. In order to add a custom visual style to your project, you must first create new folders and add your .css 
and image files to the project. To do this, follow these steps:

a. In the Solution Explorer window, right-click on your project to open its context menu and select New 
Folder. Name the new folder "VisualStyles".

b. Add a new folder within the VisualStyles folder and name it "CustomStyle".
c. Add another folder,"C1Editor", under the CustomStyle folder that you made in the last step. At this 

point, the folder hierarchy should match the following image:

d. Right-click the C1Editor folder to open its context menu and select Add Existing Item. 
e. In the Add Existing Item dialog box, navigate to the folder that holds C1Editor's Vista visual style 

(C:\Program Files\ComponentOne\Studio for ASP.NET\C1WebUI\VisualStyles), select styles.css, and 
press Add to add it to the C1Editor folder.

f. Right-click the C1Editor folder to open its context menu and select New Folder. Name the new folder 
"Images". At this point, the folder hierarchy should match the following image:

g. Right-click the Images folder to open its context menu and select Add Existing Item.
h. In the Add Existing Item dialog box, navigate to the folder that holds the images for C1Editor's Vista 

visual style (C:\Program Files\ComponentOne\Studio for ASP.NET\C1WebUI\VisualStyles); select all 
of the images and press Add to add them to the Images folder.

2. In Solution Explorer, double-click styles.css to open the stylesheet and complete the following steps:

a. Click CTRL+H to open the Find and Replace Dialog box.

b. In the Find what text box, enter "Vista".

c. In the Replace with text box, enter "CustomStyle".

d. Click Replace All to replace every instance of "Vista" with the new style name, "CustomStyle".

e. Make your preferred modifications to the style sheet.

3. Right-click the C1Editor control to open its context menu, select Properties to reveal its list of properties, 
and then complete the following:

 Set the UseEmbeddedVisualStyles property to False.  

 Set the VisualStylePath property to "~/VisualStyles".

 Set the VisualStyle property to CustomStyle (external).

Note: If CustomStyle(external) does not appear in the drop-down list, run the project and then repeat 
step 4.

4. Run the project and observe that the C1Editor control has adopted your custom visual style.

Adding Custom Visual Styles in Source View:

To add a custom visual style, follow these steps:
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1. Complete steps 1 and 2 under "Adding Custom Styles in Design View".

2. Enter Source view and enter VisualStyle="CustomStyle",
VisualStylePath="~/VisualStyles", and UseEmbeddedVisualStyles="False" into the 
<cc1:C1Editor> tag.  Your HTML will resemble the following:

<cc1:C1Editor ID="C1Editor1" runat="server" VisualStyle="CustomStyle"
VisualStylePath="~/VisualStyles" UseEmbeddedVisualStyles="False">

3. Run the project and observe that the C1Editor control has adopted your custom visual style.

Adding Custom Visual Styles Programmatically:

To add a custom visual style, follow these steps:

1. Complete steps 1 and 2 under "Adding Custom Styles in Design View".

2. Double-click the Web project to place a Page_Load event in the code editor.  

3. Set the UseEmbeddedVisualStyles to False by adding the following code to the Page_Load event:

 Visual Basic
C1Editor1.UseEmbeddedVisualStyles = False

 C#
C1Editor1.UseEmbeddedVisualStyles = false;

4. Change the VisualStylePath property:

 Visual Basic
C1Editor1.VisualStylePath = "~/VisualStyles"

 C#
C1Editor1.VisualStylePath = "~/VisualStyles";

5. Select the custom visual style:

 Visual Basic
C1Editor1.VisualStyle = "CustomStyle"

 C#
C1Editor1.VisualStyle = "CustomStyle";

6. Run the project and observe that the C1Editor1 has adopted your custom visual style.

Changing the Built-In Visual Style

Editor for ASP.NET AJAX features five visual styles – ArcticFox, Office2007Black, Office2007Blue, 
Office2007Silver, and Vista – that can be applied simply by setting the VisualStyle property. In this topic, you will 
learn how to set the property in the Properties window, in Source view, and in code.

For more information on visual styles, including pictures of each style, see Built-In Visual Styles (page 25).

Changing the Visual Style in the Tasks Menu

To change the visual style, complete the following steps:

1. In Design view, click C1Editor''s smart tag ( ) to open the C1Editor Tasks menu.
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Removing the Path Selector
By default, the C1Editor control places a path selector above the toolbar (see Path Selector (page 37)). The path 
selector can be removed by setting the ShowPathSelector property to False. In this topic, you will learn how to set 
the ShowPathSelector property in Design view, in Source view, and in code.

This topic sets the ShowPathSelector property on the server side. To see how to set this property on the server 
side, see Showing and Hiding the Path Selector at Run Time (page 63).

Removing the Path Selector in Design View

To remove the path selector, complete the following:

1. In Design view, right-click the C1Editor control to open its context menu and select Properties.

The Properties window opens with C1Editor''s properties in focus.

2. Locate the ShowPathSelector property, click its drop-down arrow, and select False.

Removing the Path Selector in Source View

To remove the path selector, complete the following:

1. Click the Source tab to enter Source view.

2. Type ShowPathSelector="False" into to the <cc1:C1Editor> tag so that the markup resembles 
the following:

<cc1:C1Editor ID="C1Editor1" runat="server" ShowPathSelector="False" />
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3. Click the Design tab to return to Design view and observe that the path selector has been removed.

Removing the Path Selector in Code

To remove the path selector, complete the following:

1. Import the following namespace into your project.

 Visual Basic
Imports C1.Web.UI.Controls.C1Editor.

 C#
using C1.Web.UI.Controls.C1Editor;

2. Add the following code, which sets the ShowPathSelector property to False, to the Page_Load event:

 Visual Basic
C1Editor1.ShowPathSelector = False

 C#
C1Editor1.ShowPathSelectory = false;

3. Run the program and observe that the path selector property has been removed.

This Topic Illustrates the Following:

In this topic, you removed the path selector from the C1Editor control. The result of this topic will resemble the 
following:

Showing and Hiding the Path Selector at Run-Time
In this topic, you will write a client-side script that will allow users to display or hide the editor's path selector at 
run time. This topic assumes that you have created an ASP.NET AJAX-Enabled Web site containing a 
ScriptManager control and a C1Editor control.

This topic sets the ShowPathSelector property on the client side. To see how to set this property on the server side, 
see Removing the Path Selector (page 62).

Complete the following:

1. Click the Source tab to enter Source view.
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2. Place the following markup beneath the <c1:C1Editor> tag:

<input id="revealPath" type="radio" name="pathSelector" 
onclick="setPathSelector(true)" checked="checked"/>
<label for="revealPath">Reveal Path Selector</label>
<br />
<input id="hidePath" type="radio" name="pathSelector" 
onclick="setPathSelector(false)"/>
<label for="hidePath">Hide Path Selector</label>

This markup creates two radio buttons with labels. Observe that each radio button's onclick property is set 
to a function named setPathSelector, which you will create in the next step. The first radio button will 
pass a value of true to the function; the second will pass a value of false to the function.

3. Place this JavaScript after the <html> tag:

<script type="text/javascript" language="javascript">
function setPathSelector(isAppearing)
{

var editor = $find("<%=C1Editor1.ClientID%>");  
editor.set_showPathSelector(isAppearing);

}
</script>

This script creates the setPathSelector function. Note that it has the receiving variable isAppearing, which 
holds the value of the selected radio button, between its parenthesis. When a radio button is selected by 
the user, this function will run and change the state of the path selector based on the value of isAppearing.  

4. Press F5 to run the program. Notice that the C1Editor control's path selector appears by default.

5. Click the Hide Path Selector radio button to hide the Path Selector and observe that the path selector 
disappears. If you click the Reveal Path Selector radio button, it will appear again.

Replacing the Spell Checker Dialog Box with a Context Menu
When a user runs a spell check in C1Editor and a misspelled word is found, the Spell Checker dialog box will 
open by default. However, you can easily eliminate the dialog box and use a context menu in its place (see 
C1Editor Spell Checker Context Menu (page 52)). To achieve this, you must set the ShowSpellCheckerDialog
property to False In this topic, you will learn how to set the ShowSpellCheckerDialog property to False in Design 
view, in Source view, and in code.

Setting the ShowSpellCheckerDialog property in Design View

To set the ShowSpellCheckerDialog property to False, complete the following steps:

1. Right-click the C1Editor control to open its context menu and then select Properties.

The Properties window opens with C1Editor''s properties in focus.

2. Set the ShowSpellCheckerDialog property to False.

3. Build the the project.

Setting the ShowSpellCheckerDialog property in Source View

To set the ShowSpellCheckerDialog property to False, complete the following steps:

1. Add ShowSpellCheckerDialog="False" to the <cc1:C1Editor> tag so that the markup 
resembles the following:
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5. Choose the correct word from the list. 

The original misspelled word changes to your selection.

Starting C1Editor in Full-Screen Mode
By default, the C1Editor control runs in partial screen mode. At run time, users can change this view themselves 
by pressing the Full Screen button on the toolbar (see Toolbar (page 37)), but there may be instances where you 
want the editor to load to a full screen. To accomplish this, you simply set the FullScreenMode property to True. 
In this topic, you will learn how to set the FullScreenMode property in Design view, in Source view, and in code.

Setting the FullScreenMode Property in Design View

To start C1Editor in full-screen mode, complete the following steps:

1. In Design view, right-click the C1Editor control to open its context menu and select Properties.

The Properties window opens with C1Editor''s properties in focus.

2. Locate the FullScreenMode property, click its drop-down arrow, and select True.
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